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OVERVIEW

o be productive with a computer, you often need a wide variety
of software tools. A word processor is essential for creating docu-
ments such as letters and memos, a spreadsheet is necessary for
developing accounting or financial applications, a database man-
agement system is the standard package for handling large
amounts of data, a charting program is needed for creating
visual representations of data, and a communications program is
required for transferring data over phone lines. If you were to purchase all
these products separately, you could easily spend over $1,000 and end up with
a lot more power than you need. Your best bet may be an integrated software
package such as Microsoft Works. To create Works, Microsoft gleaned the
most popular features of various stand-alone products and wrapped them up
into one reasonably priced package.

OsJECTIVES

After completing this overview, you should be able to:

*  Start Works

*  Gethelp

*  Use the Works tutorial

e Use menus to execute commands
e Use dialog boxes

e Exit Works

INTEGRATED SOFTWARE

X Integrated software is an all-in-one product that typically consists of five com-
ponents: a word processor, a spreadsheet facility, a database management sys-
tem, a charting package, and a communications program. Their similarity in
terms of terminology and operation—in other words, their high degree of
integration—makes these products easy to use and enables the average com-
puter user to become productive in a short time.
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The first integrated software package, Context MBA, was released by Con-
text Management Systems in 1983. Although Context MBA integrated word
processing, spreadsheets, graphics, data management, and communications, it
did not make many inroads into the business world—the programs were slow
and, many thought, not powerful enough.{In 1984, Lotus Development Cor-
poration released Symphony and Ashton-Tate introduced Framework. Both
of these integrated packages included the same five components as Context
MBA, but the power of the individual components and the marketing skills of

Lotus and Ashton-Tate enabled Symphony and Framework to be more suc-
cessful. '

»Microsoft introduced Works in 1987. The ease of use and attractive price of
Works have made it a popular integrated software product in education, in
the home, and in the workplace. Adding to Works’ popularity is the fact that
it is available in three different versions: Works for DOS, Works for Win-
dows, and Works for the Macintosh. This book deals with Works for DOS
on the PC.

Microsorr WoRrks

# Microsoft Works is a multipurpose program that consists of four tools for
four types of tasks: word processing, work with spreadsheets, database man-
agement and reporting, and communications. Charting capability is available
within the spreadsheet tool.

Word Processing X The word processing tool enables you to create a wide variety of text docu-
ments from short letters and memos to lengthy term papers and multipage
reports. The following figure displays a letter created with the word process-
ing tool.
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Italian Dream Cruises ‘
Via dei Coronari ‘
Rome, Italy

January 12, 1993 {

Cecilia Nosh |
12 Birch Street
South Pasadena, CA 92030 |

Dear Cecilia,

You're a winner! Your essay titled "Dreaming of Pizza" was judged to be the finest
essay from among five thousand entered in our contest. Now you and your husband,
Bob, will fly to lovely Venice, Italy, to enjoy an all-expenses-paid cruise around the
Mediterranean Sea.

Within the next few days, you will receive your round-trip airline tickets, a detailed
itinerary, and $25,000 in cash. Congratulations.

Sincerely,

|
|
|
|
l
|
|
Gianni Giorno ‘
President |
|
|
|
|
|
|
|

Italian Dream Cruises

v The spreadsheet tool is ideal for performing mathematical calculations in a
grid of rows and columns called a spreadsheet or worksheet. For example, you
can create a checkbook-style register that automatically calculates the current
balance for each transaction. A business can keep track of accounts receivable
and accounts payable. A professor can enter students’ test scores and use the
tool to calculate the average score. The following figure displays a checkbook
register that was developed and then printed using the spreadsheet tool.
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Checkbook Register
January
Number Date Transaction Payment Deposit Balance
103 Jan 1 Rent 355 1,230.56
104 Jan 3 New bowling ball 105 1,125.56
Jan 10 Money from Aunt Gretta 75 1,200.56
105 Jan 12 New watch 250 950.56

(h(]l’ﬁl’lg # In Works, the charting component is found within the spreadsheet tool.
Although charting is not considered a separate tool in Works, the package
offers a sizable set of options that enables you to create a visual representation
of spreadsheet data. You can create charts to forecast sales, analyze the distri-
bution of test data, or track stock-market trends. The following figure con-
tains a bar chart and a pie chart that display the distribution of letter grades
for Professor Brooks’s class.

Professor Brooks
Grade distribution

12 =

10

gL

6 |

4l

2

0 - —

A's B's C's D's F's

Grades

F's (10.9%) N7

D's (21.7%)

B's (19.6%)
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7 The database and reporting tool enables you to manage large amounts of
data. A database, a collection of highly structured data, can consist of a mail-
ing list, a statement of warehouse inventory, or even data about a stamp col-
lection. For example, if you owned a video store, you could create a list of
videos (that is, a database) and then quickly sort and print the entire list. You
could find and edit specific video titles and add new titles easily. Once you've
created your database, you can create a report, which groups and summarizes
data. The following figure presents a report in which video titles have been
sorted by category.

Video List
Title Cateéory Rating Price
From Here to There Comedy PG-13 20.25
Aliens are Stealing my Socks Comedy PG 15.95
The Green Fields of Iceland Documentary PG 15.75
Apache Helicopters and You Documentary PG 14.95
Discovering Banana Slugs Documentary PG 29.95
Oh Yes, Oh Yes, Oh No Drama R 16.95

I Lost My Heart at the Cardiologist
Festival Drama PG-13 19.95

" The communications tool allows your computer to communicate over tele-
phone lines with another computer. If you need to look up current stock-mar-
ket prices, you can dial up a stock-market information service. If you want to
read about late-breaking news events, you can call a news service and browse
through its news bulletins. You can even send, electronically, a letter to a
friend in another part of the country. The following figure shows how Jim, in
Los Angeles, uses telephone lines to communicate with Bob, in New York.

7
To use the communications tool, your computer must have a modem. A
modem is a piece of hardware that translates computer signals into a form
that can travel over phone lines.

Hi Bob,
How are things
in New York? LA

is just fine.
Your friend,

Hi Bob,
How are things

in New York? LA
is just fine.

Your friend,

Jim

—m
o
Jim Z
B e T e
D
W ‘ e
4!!!!!!!!!!;] N ™ YW
Los Angeles New York
USiﬂg the Tools Togeiher Although each of the tools in Works is not as robust as a stand-alone pro-

gram, the combination of the tools provides you with a powerful, easy-to-
learn product. For example, Works’” word processing options are not as
comprehensive as a full-featured word processor such as WordPerfect; how-
ever Works’ simplified approach allows you to learn quickly how to create
text documents. Once you understand how to use the word processor, you




MSW-6
MS Works 2.0

can readily learn the other tools, since they follow a direct, consistent com-
mand structure.

Since all the Works tools are found within one package, using them together
is a straightforward process. For example, the following figure contains text
that was created with the word processing tool and combined with a
spreadsheet and chart that were created with the spreadsheet tool.

Australia's population i

Australia has over 14 million people and seven states. The following
spreadsheet and chart describe the population distribution.

State Capital Population ‘
Western Australia Perth 1,273,624
Northern Territory Darwin 123,324
South Australia Adelaide 1,285,033
Queensland Brisbane 2,295,123
New South Wales Sydney 5,126,217
Victoria Melbourne 3,832,443
Tasmania Hobart 418,957

Tasmania (2.9%) Western Australia (8.9%)
oS Northern Territory (0.9%)

South Australia (9.0%)

Victoria (26.7%)

\

\
|
]
]
]
]

Queensland (16.0%)

New South Wales (35.7%)

Usin Tris Mobute

00000 0RO OORONOROROEOINOSRPRORPOTR TPOON

T'his module is designed to make learning Microsoft Works easy. You will
learn how to use all the Works tools by completing a wide variety of hands-
on projects. Conceptual material is separated from numbered hands-on
instructions to make using the module in a lab setting easy. You will get your
hands on the keyboard immediately and learn to use the Works online help
facility so that you can get help when you need it.

T'he module is divided into an overview and six parts. Each part consists of
from one to four projects that describe how to use a particular tool or how to
use the tools together. The material in the overview and in each project is
reinforced with a summary, a list of key terms, and study questions; each proj-
ect also has review exercises. Each part ends with one or more additional proj-
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ects that draw on all the skills learned in that part. At the end of the module is
a command reference section; a glossary, which defines all the key terms; and
an index.

System Requirements
*  MS-DOS or PC-DQOS, version 2.0 or higher
* 512 Kilobytes of main memory
*  Two floppy disk drives or one floppy disk drive and one hard disk drive

*  Any standard monitor (a graphics monitor is required for creating charts)

A Note fo the Student Instructions in the projects describe how to execute commands with a mouse
and with the keyboard. Many operations are faster with the keyboard, since
you don’t have to take your hands off the keys to move the mouse. Therefore,
you will often find keyboard instructions only.

A typical instruction looks like this:

» Tosave afile:

1. Mouse: Choose Save from the File menu.

or Keys: Press FS

Use the following as a guide when executing commands with the keyboard:

When instructions include a keycap, such as the one shown to
the left, press and release the key indicated. Press firmly but
quickly. A key will repeat if you hold it down too long.

B Press and release the key whose name is shown in bold. Single-
character keys are shown in the bold text font.

FOB Press and release the first key; then press and release the
second key.

(ALTHF While holding down the first key, press and release the second.

When you are instructed to type a string of text, it is shown in a bold
y g )

typewriter font to distinguish it from regular text. An instruction to
enter text looks like this:

1. ‘lype vacation Packages and then press

Take some time to become familiar with the keyboard layout and the other
components of your computer system. The instructions in this module
assume that you know how to operate the keyboard and printer.

USIﬂg a Mouse Microsoft Works allows you to use a pointing device to perform many opera-
tions, such as executing commands, selecting text, and scrolling the screen. A
mouse is a handheld pointing device. When you move the mouse on a flat sur-
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Configuring Works

face, you cause corresponding movement of an onscreen pointer. A trackball
has the same function as a mouse, but its movement is confined b because 1th/

attached to a stationary device. The trackball is similar to the ball in a roll-on
deodorant—only part of the ball is visible at a time and, though it can roll, it
can’t go anywhere. By using your fingers to move the trackball, you can make
the pointer move anywhere on the screen.

The position of the pointer indicates where a subsequent action will take
place. In Text mode, the pointer looks like a small block; in Graphics mode, it
looks like an arrow. Whn using a mouse or trackball to move the pointer,
you will come across the terms ¢lick, and drag. When you click an object, such
as a command name, you place the pointer on it and then quickly press and
release the left mouse button. To drag an object, you place the pointer on an
object and then hold down the mouse button while moving the mouse. The
object will move along with the pointer until you release the mouse button.

Several settings control how Works will function. For example, you can dis-
play information on the screen in either Text or Graphics mode. In Text
mode, what you see on the screen is not always the same as what you see
when you print the display. Graphics mode providesﬂ_Y_SﬂY G (what-you-
see-is-what-you-get) capabilities—your screen display is almost identical to’

the prlnted page. For example In Text mode, on screen italic characters
appear either highlighted or in a distinct color; in Graphics mode, on screen
italics appear with a forward slant, which is how they look when prmted

Most of the figures in this book were created in Text mode because it is faster
than Graphics mode for many operations, such as executing commands and
scrolling. Graphics mode was used in figures dealing with the charts and text
fonts. You can use either Text or Graphics mode. The mode you choose, how-
ever, may cause your screen to look a little different from the figures in the
book. The command that follows demonstrates how to change screen modes.

» To display the current Microsoft Works settings:

1. Mouse: Choose Works Settings from the Options menu.
or Keys: Press (ALmrO W

When you see the following figure, you can select a particular option by
using the mouse to click it. To choose an option by using the keyboard,
you can press to jump from one group of options to the next and
then use the arrow keys to make a particular choice.
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B £1C8 Uptions I

Co ntry: Units: Screen c lors: ines:
1 1 1
T (+) nches Color 1 1 T
Australia C ) C ntimeters Color 2 ! 43
Canada (English) £l () 1 Pitch Color 3 g 50 i
Canada (French) §,n () 12 Pitc m_sg il
France i () Poin s i 1
i | 1 1
Use templates for: Modem port: Dial type: Screen mode:
[ 1 ord Processor (+) COM (:) Toe () Tet
[ 1 preadshest () COM () ulse ( ) raphics
[ 1 atabase
[ 1 ommunications Microsoft Uorks
Version 2.00A
DR <Cancel>

<F1=HELP>

Sets screen colors, lines, and other Works settings.

Notice that in the figure, the mode is set to Text. Also notice that the
screen color is gray, the units are inches, and the number of lines per
screen is 25. If your settings are different, you can either change them to
match these or leave them as they are. Usually Works has been preset to
work optimally with the computer you are using.

2. When you have finished adjusting the settings, press

Starting Microsorr Works

The method that you should use to start Microsoft Works depends on how
your computer is configured, or set up. If none of the following procedures
works, you may need to get assistance.

Using a Hard Disk If you are using a computer with a hard disk, you will usually find each appli-
cation, or software package, in a separate subdirectory. To start an application
like Works, you will enter the name of the subdirectory that contains Works.
Then you will type the application’s name (or some variation of it).

B To start Works if it is on a hard disk:

1. If the computer is not on already, turn it on to boot DOS.

2. Type CD WORKS and then press

WORKS is the name of the subdirectory containing Microsoft Works. If
the command does not work, your subdirectory might be named differ-
ently or Works may be on a disk in another drive, such as D..

3. Atthe DOS prompt type WORKS and then press
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Using Two F|0ppy Disks Some computers have no hard disk; they have two drives for floppy disks, and
the drives are called A: and B:, respectively. Typically, the A: drive contains
the application disk (Works) and the B: drive contains the data disk (the disk

on which you save all your work).

» To start Works on a system with two floppy disk drives:

1. Insert a disk containing DOS into the A: drive, and then turn on the
computer.

2. Pull out the disk containing DOS and insert the disk containing
Works.

Sometimes DOS and Works are on the same disk. In this case, you can
skip this step.

3. Insert the data disk into the B: drive.

4. At the DOS prompt type WORKS and then press

Using a Menu System Some computers are set up to display a menu system that provides you with a

quick way of starting applications. Since a menu is a list of choices, a menu
\“

system for starting applications lists the names of the applications that are
ava 111ablc—such as WordPerfect, Lotus 1-2-3, and Works, for example. Typi-
cally, you use the arrow keys to highlight the name of the desired application;
then you press (ENTER). In some menu systems, you press a key that corre-
sponds to the application of your choice.

» To start Works from a menu system:

1. If your computer is not already on, turn it on.
2. Enter your ID number if asked to do so.

3. From the menu system, choose Works.

Geming Hete

Works has a comprehensive help system that provides information on com-
mands, functions, messages, and procedures. Also available is an online tuto-
rial that guides you through lessons step-by-step.

» To view the Help menu:

1. Mouse: Select the Help menu.
or Keys: Press (ALT-H

You should see the following menu.
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Explains houw to use Works” help.

The Help Index is a good place to start when you aren’t sure how to do some-
thing. For example, suppose that you need help on aligning paragraphs.

» To get help on aligning paragraphs:

1. Mouse: Choose Help Index.
or Keys: Press H

You should see the following screen.

File Options [[O3TH
MICROUSOFT WORKS HELP INDEX
Help categories: Basic Skills Topics
1
(-) ASIC SKILLS [Backing Up Files |}
{ ) NTRODUCING THE TOULS Cancelling a Command I
( ) EYBODARD Choosing Commands
() OUSE Closing Help
( ) DMMANDS Closing a File
{ ) ROCEDURES Creating a New File
DOS Commands
1. Hold down the Alt key and Dialog Boxes
press the First letter of the Drives and Directories
category you want. Exiting Works
2. Use the arrow keys to select Moving Through a File
a topic from the Topics list. Naming a File
3. Press Enter. Notes To Uersion 1 Users
To exit Help: Press Esc or choovse Cancel. opic < essoms)> <(Cancel>

Pisplays Help Index.




